How can we help you?
Use the links below to find instructions, software training, one-on-one
support, technical specifications, or other resources to get Sage 300
ERP working smoothly for your business! Your Sage Business Partner
is also an excellent resource to consult when you have questions about
Sage 300 ERP.
I'm setting up Sage 300 ERP and need information or assistance
I'm looking for instructions to complete a task within Sage 300 ERP
I think something is broken, or I'm getting error messages
I'm looking for downloads, updates, or technical specifications
I want to become a more skilled user of Sage 300 ERP
I want to share knowledge with other Sage 300 ERP users
I want to contact a Sage 300 ERP representative

Using Account Code Change
Individual Changes

Multiple Changes

Posting Changes

The Change List window is Account Code Change's main window. It
displays change list entries, a listing of proposed but not posted Account
Code changes, as in the following example:

Adding Changes
There are three choices for creating entries for the Change List. One way
is to add entries to the Change List individually from the New Window. You can
also create multiple entries by using the Change by example feature. The third
way to create entries for the Change List is to import the changes from an
external file in Excel, Lotus or ASCII Text format.
Editing Changes
To edit an entry in the Change List, highlight the desired entry and then
either double-click it or press the Modify button. This will open the Modify
Window.

Deleting Changes
To delete an entry in the Change List highlight the desired entry and then
either press the Delete button or the DEL key.
Printing the Change List
The Change List can be reviewed on screen by visually scanning the List.
It can also be printed to the screen or sent out to the printer for review.
Select Print Preview from the File menu and then press the Change List
button to print the Change List to the screen. Select Print from the File
menu and then press the Change List Button to produce a hard copy of
the Change List.
Posting Changes
When the Change List is complete, you are ready to post the changes which will
update all of your Sage 300 ERP files.
Note: User may be required to make their changes manually on some
files if the company has activated the Cost Center Overrides option in Canadian
Payroll or US Payroll.

Introduction
Account Code Change for Sage 300 ERP allows you to change G/L
Account Codes quickly and easily. Just add in the new account code to
the account code list displayed on the window.
After entering and editing all of your changes, post them. All the records
in your Sage 300 ERP system are automatically converted.
After your changes are posted, print the Audit Trail report for a list of the
changes.
Key Features
Change account codes quickly. All information, including account
balances, history and transactions will be associated with the new
code.
Generate multiple changes from one entry by using the change by
example feature.
Change the length of existing G/L account code segments, padding or
removing numbers to the left or right end of segments that you are
changing.
Change account code segment delimiters.
Account codes are changed in General Ledger, G/L Subledger
Services, Bank Services, Tax Services, Accounts Receivable,
Accounts Payable, Inventory Control, Order Entry, US Payroll,
Canadian Payroll, Purchase Orders, and Project and Job Costing.
Print a list of changes before they are posted. After posting, print an
audit trail of all changes.
Combine account codes. All information including account balances,
history and transactions will be combined together into another
existing account.
Copy account codes quickly. All information such as the account
master file and allocation instructions is copied to the new account.
Use the enhanced wildcard feature with Change By Example.
Import changes from other file formats such as Excel, Lotus and

ASCII Text.
Use speed buttons to access features such as Change By Example,
Import and Message Log.
Known Issue
Account Code Change does not support more than 1000 change
entries in the Change List.

Adding Individual Changes
Change by Example

Posting Changes

The New window, Action box offers three change entry options:
Change, Combine and Copy. These options create single change list
entries, in contrast to Change by Example which produces multiple
change list entries. Let's begin by looking at the Change option.
For Change

Start by selecting 'Change' from the Action type and then choose the
Account Code that requires changing. This can be done by typing in the
Account Code, moving through the Account Codes using the Up and
Down Arrow keys, or clicking on the List Button and finding the Account
Code.
If the Structure Code is to be changed, then decide on the new Structure
Code by clicking on the List Button beside the Structure Code field. Then
enter the new Account Code and change the Description as required.
Once you are satisfied with the change then click the OK Button to add
this entry to the Change List.

The display format of the new Account Code always reflects the Account
Structure. The Account Code segment accepts any numeric value and
valid values for the other segments will be available through the selection
boxes.
For Combine

Start by selecting 'Combine' from the Action type and then choose the
Account Code that needed to be combined. This can be done by typing in
the Account Code, moving through the Account Codes using the Up and
Down Arrow keys, or clicking on the List Button and finding the Account
Code.
Following the same procedure as above to enter the Account code that
will be kept after the combine and also change the description as
required. Once you are satisfied with the change then click the OK Button
to add this entry to the Change List.
For Copy

Start by selecting 'Copy' from the Action type and then choose the
Account Code that needed to be combined. This can be done by typing in
the Account Code, moving through the Account Codes using the Up and
Down Arrow keys, or clicking on the List Button and finding the Account
Code.
If the Structure Code is to be changed, then decide on the new Structure
Code by clicking on the List Button beside the Structure Code field. Then
enter the new Account Code and change the Description as required.
Once you are satisfied with the change then click the OK Button to add
this entry to the Change List.
The display format of the new Account Code always reflects the Account
Structure. The Account Code segment accepts any numeric value and
valid values for the other segments will be available through the selection
boxes.

Change by Example
Adding Changes

Posting Changes

Change by example, unlike the New window Action box options,
produces multiple and not single change list entries. Using a simple
pattern matching utility, Change by Example selects any Account Codes
matching the pattern you define, then uses the same utility to create
replacement codes. Let's learn how it works.

First, choose the Account Structure that applies to the changes you want
to make.
Next, select the segment that will be changed by clicking the tick box
above the particular segment or pressing Tab until you highlight the box
and press the Space Bar.
Enter the From and To choices for that segment by choosing the correct
values from the list box. Click the Match button.

Once the matching is completed, the number of changes found, rejected
and added will be displayed on the bottom of the window.

Pressing Done adds all matched and error checked records to the
Change List. Records are rejected for the following errors:
1.There is already a change item for this account code.
2.The new account code already existed in the account master file.
3.The new account code has already been assigned to one of the items
in the change list.
In the example above, all Accounts starting with code 401 with a second
segment value of 100 will be changed to account code 901 and segment
value changed to 300. You can also choose multiple segments to match.
e.g. 4000-100-?? To 4000-300-??.
NOTE ">" is the wildcard symbol. Insert a wildcard into account code to
represent an undefined character by pressing Shift + Spacebar.

Import Change List from Other Files
After selecting the File menu Import choice, the following window is
displayed.

To import a file, type the file name into the edit box or press the Browse
button to search for the file. The file must follow the specified file layout in
order to import the changes successfully.
After selecting the file, press the Import button and the change list will be
imported.

Press the Done button to add the changes to the Change List. Those
changes that were rejected will not be included.

Changing G/L Account Segments
In addition to changing account numbers, you can change the segments
in your account numbers.
You can change the delimiter that separates each of your account
segments. For example, you can replace a dash ( ) with a slash (/). The
account 1234-100-10 would become 1234/100/10.
You can also change the length of any of the segments in your account
number (such as the account or department segment).
If you decrease the length of the segment, you can choose to truncate
the characters from the left or right side.
If you increase its length, you can add the characters of your choice to
the left or right of the existing segment.
For example, you might choose to increase the length of your account
segment from 4 to 6. You could set Account Code Change to add 10 to
the front of each segment. So, the account segment 1234 would become
101234.
To change account code segments
1.Click the G/L Segment Change icon (
) on the Toolbar or choose
G/L Segment Change from the Tools menu.
2.Choose the account segment that you want to change.
3.If you wish to change the delimiter, you can select one in the To New
Account Delimiter field.
4.If you are changing the length of an account code segment, enter the
new length of the segment in the To <name> Segment Length field.
If you are shortening the account code segment, choose whether
you wish to delete characters from the left or right side of the
segment.
If you are lengthening the account code segment, choose whether
you wish to add characters to the left or right side of the segment.
Then, in the Pad Values With field, enter the characters that you
wish to add.

In the following example, the delimiter is changed to a slash and the
segment lengthened from 4 to 6 (with the numbers 10 added to the
front of the account segment).

5.Click OK.
6.To confirm the process, click Yes for each warning. All entries are
added to the Change list.

Editing Changes
The Modify window is similar to the Add window, except that the action
type and old Account Code cannot be changed.

If the Structure Code is to be changed, decide on the new Structure Code
by clicking on the List Button beside the Structure Code field. Then
change the new Account Code and the Description as required. Once
you are satisfied with the change then click the OK Button to add this
entry to the Change List.
The display format of the new Account Code always reflects the Account
Structure. The Account Code segment accepts any numeric value and
valid values for the other segments will be available through the selection
boxes.

Posting Changes
Adding Changes

Change by Example

Start the posting process by clicking Post, located in the lower right
corner of the Change List window. Once the Post button is clicked you
will see the following Warnings:

If Cost Center Overrides option has been setup in payroll, the above
message box will appear. If you proceed to post the change, you have to
ensure that the account code that you are going to change is not the
overriding account. Please read the section Cost Center Overrides in this help file.

It is always important to ensure that your data is backed up prior to
posting the changes. Then, if you are prepared to post the changes, click
on the Yes button. The posting will proceed and the following progress
window will appear.

When the posting has completed successfully, you are ready to print the
Audit Log.

Canceling a Posting
You can cancel a posting at any time by choosing Cancel. Once chosen,
the following confirmation message is displayed.

Select Yes to cancel the posting or choose No to continue the posting.
NOTE Canceling a posting in mid-process means that some change list
entries have been completed while others have not. This poses a
significant data integrity problem. We strongly advise you to restore
the company data before beginning any other operations.
Errors during Posting
If errors occur, print the Error Log and restore your backup of the company
data. After reviewing the errors, make the appropriate corrections and
redo the posting. It is REQUIRED that the Error Log be purged from the
system prior to any re-posting of the Change List.
Warning after Posting

Some adjustments or checking need to be done if there is message
inside the Warning Log. Review the Warning Log and make the appropriate
adjustment.

Cost Center Overrides for Payroll
Note: DO NOT change account codes for a distribution account in
Payroll Earnings and Deductions with Cost Center Overrides
without understanding the following implications. To do so may
cause data integrity errors.
The Cost Center Overrides Feature allows you to specify the G/L account
segments you wish to override for the default segments in the GL
distribution accounts in Payroll Earnings and Deductions for each
employee. During payroll transaction processing, the default segments
are overridden by the specified segments.
Before posting any account code changes, the following issues should be
considered:
Do not change an account code that is a distribution account in Payroll
Earnings and Deductions, if...
changing the account code will lead to an "account code does not
exist" error while posting payroll transactions or doing data integrity
checks.
changing the account code will either generate a payroll transaction
posting error or post the payroll transaction to the wrong GL
distribution account. For example: a distribution account that has two
segments is changed to a new account code that only has the
account segment. No error will occur in posting the payroll transaction
because there is no segment to be overridden. Instead, the payroll
transaction will be posted to the new account. This may result in an
incorrect distribution of employee earnings and deductions.
Note If account code changes that result in the above errors have
already been posted, changing the account code back to the
original account should fix the errors.

Error Messages
Common Error Messages in Account Code Change
New Account Code cannot be the same as the current one.
You are attempting to add or modify a change item with the new Account
Code the same as the old one.
New Account Code already exists in the Account Master file.
You are attempting to add or modify a change item with a new Account
Code which already exists in the Account Master.
New Account Code has already been assigned in another change
item in the change list.
You are attempting to add or modify a change item with a new Account
Code which has already been assigned to another change item.
There is already a change item for this Current Account Code.
You are attempting to add or modify a change item for an Account Code
which already has a change item specified.
Account Code cannot be blank.
You are attempting to add or modify a change item with the Account
Code left blank.
Account Code cannot have spaces.
You are attempting to specify an Account Segment Code with a code
which has spaces.
"X" is not a valid code for this segment.
You are attempting to specify an Account Segment Code which is not set
up in General Ledger.
Invalid Account Structure code.
You are attempting to specify an Account Structure Code which is not set
up in General Ledger.
There were entries in the Error Log which indicate problems in a
previous posting. Examine the Error Log, correct the problem and

purge the log before proceeding.
Errors occurred during the last posting. You must purge the error log first
before you can redo the posting.
"X" error(s) occurred during posting. Review the Error Log for
details. To ensure data integrity, restore backup of company data
and redo the posting again.
Errors occurred during posting. You should examine the error log to
locate the problem and restore backup of company data before redoing
the posting.
You do not have authority to run this program. Contact your System
Administrator.
You do not have access right to execute Account Code Change.
You must start this application from within Sage 300 ERP System
Manager.
ccount Code Change must be started from within Sage 300 ERP ERP.
Combining a multicurrency account into a non-multicurrency
account is not allowed
You are attempting to combine an account which setup to be
multicurrency into an account which is not. However, you are allowed to
combine non-multicurrency account into multicurrency account but not
the other way around.
Combining a non-zero balance sheet account into an income
statement account is not allowed
You are attempting to combine balance sheet account with non-zero
balance into income statement account. In order to do combine the
balance sheet account must have zero balance.
Multiple operations for the same Account Code is not allowed
You are attempting to make multiple changes such as change, combine
and copy for the same account.

About the Message Log
About Viewing / Previewing Message Logs About Printing / Purging Message Logs

Another addition to Account Code Change is the Message Log window
that displays the following logs:
Audit Log — contains the successfully posted Change List entries.
Retaining a printed copy of this log helps you keep track of changes
to your database. Entries remain in this log until they are purged.
Error Log— contains the Change List entries that were not
successfully posted and a brief explanation of the reason. Retaining a
printed copy of this log helps you resolve current errors and avoid
future ones as well. Entries remain in this log until they are purged.
Warning Log — contains warnings of potential database problems,
unrelated to Account Code Change, which were detected during a
posting. Entries remain in this log until they are purged.
To open the Message Log window
Click
on the Toolbar or, from the View menu, choose Message
Log. The following window is displayed:

Message Log Window showing the Audit Tab
To switch between log views
Simply click on the appropriate log tab. From the Message Log
window, the various logs can be viewed in a Print Preview window,
sent to a printer, or purged.
About Warning Log Messages
Warning Log messages can occur during both successful and failed
postings. At the time of writing, there is only one possible and very rare
warning message that Account Code Change might report during a
posting.
There is a potential index problem in this file.
This warning means that Account Code Change has detected a
corruption in your Sage 300 ERP data that is unrelated to any changes
made by the Account Code Change program. If this message occurs, it
indicates significant data corruption issues. Restoring your data might not
correct the problem. In fact, the nature of the error indicates that your
backup data may already be corrupted. To resolve this issue, run the

Sage 300 ERP Data Integrity program on the current data and post a
small change to verify the problem has been corrected. If the error
persists, contact Sage 300 ERP Technical Support.

About Viewing and Previewing Message Logs
The Messages Logs — Audit, Error and Warning — can all be viewed,
printed, and purged using the following procedures.
Viewing any Message Log
The following procedure can be used to view any of the Message Logs.
To view a Message Log
1.Click
on the Toolbar or from the Change List window; select
Message Log from the View menu. The Message Log window is
displayed.
2.Choose the desired Log Tab from the Message Log window. The
desired log is displayed in the Message Log window.
3.Use the scroll bars, if necessary, to view the entire log.
To Preview a Message Log in a Print Preview window
1.From the Change Listwindow, select Print Preview from the File
menu. A popup menu listing all the logs containing entries is
displayed.
OR
From the Message Log window, select the desired log tab. The
contents of the selected log are displayed.
2.From the popup menu, choose the desired log to preview.
OR
From the Message Log window, select Print Preview from the File
menu. The Print Preview window displays the desired log.
3.Use the navigation controls to display additional pages. See Print Preview
for more information.

About Printing / Purging Message Logs
Purging clears message logs of their entries. Entries remain in any
Message Log until it is purged. Because Message logs must be printed
before being purged, the purge utility is part of the printing process.
Before posting another Change List, the Error Log must be purged in
order to continue. If you do not purge the Error Log and attempt a
posting, the following error message is displayed:

Purge Error Log Warning Message
If you haven't purged the Error Log and attempt another posting, this
message is displayed.
The following procedure can be used to both print and purge any of the
Message Logs. You can also review a log before printing using Print
Preview. A full discussion of print preview's review options is found in the
About the Print Preview section.
To print / clear any Message Log
1.Select the Change List window's File menu Print / Clear choice.
OR
Select the desired Message Log window's log tab. The contents of
the selected log are displayed.
2.Choose the desired log to print.
OR
Select from the Message Log window, the File menu Print / Clear
choice.
The Print dialog box is displayed.
3.If desired, specify the printer options, page range, print quality, and so
forth. Unless otherwise specified, the log is sent to the default printer
as designated in Windows.

4.Choose OK to proceed or choose Cancel to stop printing. After
printing is complete, the Log Purge dialog box is displayed.
5.Choose Yes to proceed with the purge or choose No to cancel the
process. Check to make sure the log is properly printed before
proceeding with the purge.

About Importing Files to the Change List
While Change by Example is a powerful change tool, pattern matching
might not readily isolate the precise changes you require. Instead, you
can generate Change Lists from a database or spreadsheet containing
an account code report or other account code listing. External files can
use the Change, Copy, and Combine options. This permits greater
flexibility because instead of inputting changes directly within Account
Code Change, you can import Change List entries from an external file of
the following file types:
Lotus 123 (V3.0 — V5.0)
MS Excel (V2.1 — V7.0 Note: MS Excel 97 is not supported)
dBase III and higher
FoxPro and Clipper
ASCII comma-separated text file
Preparing files for Import
In order to import changes successfully, the following Account Code data
format must be observed.
Explaining the Account Code data format
The Account Code data format has the following common features,
regardless of what application is used to create the import file:
Each row or line represents one (1) account record.
Each record contains five (5) fields in the following order:
Field 1

Field 2

Field
3

Old
Account
Code

New
Account
Code

New
Action
Structure
Type
Code

Field 4

Field 5
Description

Field Three, Action Type, has three (3) predefined values, as follows:
To take the

following
action

Input

Change
Combine
Copy

0
1
2

Fields Four and Five — Structure and Description - must contain data
even if you don't intend to change them. The following table shows
your field entry options and their results:
Field
Contents
Original
data
Changed
data
Single
blank
space
(no quotes
required)

Change Result
The original data replaces itself
(useful for correcting typos, etc.).
The changed data replaces the
original data.

The original data is left untouched.

In addition, each file type has it's own unique requirements as the
following listing shows.
ASCII delimited text file
The first row is the title row; no other information except the title
should appear in this row. If you don't want to include titles, include
the row but leave it blank.
Commas separate the fields and each field's contents must be
enclosed within quotes.
NOTE You can use Windows Notepad to create this file.
MS Excel files
The first row is the title row; no other information except the title
should appear in this row. If you don't want to include titles, leave it

blank.
Columns separate the fields and each field's contents must be
enclosed in its own spreadsheet cell.
Lotus 123 files
File layout is the same as MS Excel file
dBase III and higher files
File Import only recognizes three DBASE data types: String,
Numeric and Date. Any other data types such as memo fields will
be ignored.
Consequently, fields must observe the following formats:
Field

Must be
formatted as

Old
Account
Code
New
Account
Code
Action
Type
New
Structure
Code
Description

a string field
a string field
either a string or
an integer field
a string field
a string field

FoxPro and Clipper files
File layout is the same as dBase III

About Print Preview
The Change List can be printed directly or reviewed using the Print
Preview option and then sent to the printer. The Print Preview window
offers a variety of tools for reviewing a document.
About the Print Preview window
The Print Preview window provides the user with several tools for
reviewing the print document prior to printing.

Using the Print Preview Icons

